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1. Introduction

bcAdmin will make working with batcorder recordings as well as other bat call files a lot
easier. It takes away most of the organizing and supports you when analyzing. It is fine
tuned to work with the batcorder and presents an elementary part of the batcorder-system.
It is the database that stores information and does intelligent analysis.

The applications is primarily focused on the management of recordings and their meta in-
formation as well as the output of data compilations based on the raw data. In addition it
automatically searches your recordings for bat calls, and takes measures of all found calls
so batldent can identify bat species. The meta information belonging to recordings are
stored in a database-like file and can be filtered and otherwise manipulated.

bcAdmin was growing tied to the batcorder from its first release more than 10 years ago. It
had to be able to cope with ever new arising tasks. bcAdmin4 is definitely the most power-
ful version we released and contains many new functions that were shaped from your in-
put.

2. Installation

System requirements for running bcAdmin4 are an Apple Mac with Intel-CPU running Mac
OS 10.15 or newer. We do recommend macOS 12 or newer and it may become mandat-
ory in future.

We recommend at least 4GB of memory. After downloading the application zip archive, ex-
tract it into your Applications folder. If you are already using an older version of bcAdmin,
we recommend you first rename the old version. To use the automatic identification you'll
need batldent and its components.

bcAdmin4 features an update process and will inform you if updates are available on our
server. It can download the updates. To install the updates you have to quit bcAdmin 4 and
copy the downloaded file to the applications folder (or where your bcAdmin copy resists).
You can overwrite the existing version, the data is stored apart from the application file.
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3. Overview of bcAdmin4

bcAdmin is designed to manage and analyse your bat call recordings. It combines a data-
base with a sound analysis tool and creates tables and graphs for your reports. It works
together well with batldent and thus can obtain automatic species identification through it.
That way you quickly get per species activity patterns and reports. In short: no need to
switch between sound analysis app and spreadsheet app - it's all within bcAdmin.

Since many steps in the analysis process are automated within bcAdmin, working with
large datasets as created by passive recording systems is at least possible in a meaningful
way. Only due to the objective call measurement and identification a basis for comparison
of locations and nights is possible. Wether you‘re doing acoustic monitoring, comparison of
activity for consulting or diversity indices - bcAdmin is the optimal tool for your work.

While the app is optimized for batcorder recordings, it works well with files of other sys-
tems as well. Nevertheless, many devices produce recordings with echoes or otherwise
low sound quality. For these taking of automatic measurements may give less viable res-
ults or none at all. Note that some features of bcAdmin require special form of data only
produced by the batcorder. Thus, some features may not work or only work partially with
other recordings.

Recordings are connected in bcAdmin to meta information regarding the sampling efforts
(sessions) and location. Sessions and recordings may be filtered or grouped based on this
data. Analysis of calls is done using an unique and lightning-fast algorithm. It works in
batch-mode, finds every call matching your settings and takes measurements for each
call. All calls can also been displayed on a per file basis and you can manually correct calls
misclassified by batldent (working for European bat species only). Per recording a maxim-
um of three species entries is possible.

The comparison of data is possible due to the objective approach of call and species iden-
tification. Using these results calculations of activity based on recording count, recording
duration or other activity groupings can be done. Different functions also visualise your
data. Complex graphs can easily be created by a few clicks. In addition you can export
data, graphs and do further calculations in any other application you like.

Manual bcAdmin 4.0 Version 1.4.3 - Page 5



[ ) [ ) AG-Fledermaus-MS.bcAdmin4sqgl —

@ | 253 &3 In g || B | e o

New session Add recording Find calls ID calls Import results File browser Species list Species tree Night graph Year graph Correlator Locations  Share
Count Species v Genus/Group v Classification v Prob. v Q Q
Sort sessions ... v Marked Filename Time A Dur Calls  Genus Species Co
‘6 Iil):o(; - 07:00 N - 100616-WOLTIER030-00001.raw 21:43:20 1,60s 18 Pipistrellus  Ppip 100%
t , Miinst
ALL RECORDINGS eerdestrasse, Minster —  100616-WOLTIER030-00 21:57:20 _160s 17 Pipistrellus Ppip 100%
@ 30.0815  —  100616-WOLTIER030-00 A s 9 Pipistrellus  Ppip 97%
SINGLE RECORDINGS 20:00 - 07:00 —  100616-WOLTIER030-00) ReCOfdlngS 5s 9 Pipistrellus  Ppip 0%
Heerdestrasse, Miinster B
—  100616-WOLTIER030-00) s 22 myotis Mdau 0%
PROJECTS @ 31.0815  —  100616-WOLTIER030-00006.raw 22:13:32  0,83s 5 Myotis Mdau 0%
2°:°‘; =G0 . —  100616-WOLTIER030-00007.raw 22:32116 0,465 1 Myotis Mdau 0%
H t , Miinst
LOCATIONS cerdestrasse, Minster —  100616-WOLTIER030-00008.raw 22:37:02 1 Pipistrellus _Ppip 78%
HisToRY @ 01.0915  —  100616-WOLTIER030-00009.raw 22:41:10  0,70s 4 Ppipistrellus  Ppip 88%
20:00 - 07:00 —  100616-WOLTIER030-00010.raw 23:03:54  0,64s 4 Ppipistrellus  Ppip 88%
Heerdestrasse, Miinster .
MARKED —  100616-WOLTIER030-00071.raw 23:48:46 0,465 3 Myotis Mkm 75%
@ 09.0915  —  100616-WOLTIER030-00012.raw 23:49:12  1,25s 12 Myotis Mkm 0%
DED=TAD —  110A1R-WOI TIFRNRO-NON1R raw 00:29:58  08%s 7 Dinictralliic  Pnin 07%
FILTER Hof SH, Munster
@ 0015 | (&) =
Groups Sessions
@ T1.09.15
19:30 - 07:15
Hof SH, Miinster
@ 12.09.15 Species Pre step
19:30 - 07:15 ) marked P
Hof SH, Manster Ppip 0.78 Phoch 0.78 B = 8
checked
@ 13.09.15 e > Recording list
19:30 - 07:15
Hof SH, Mnster not classified |T] +
Select a location <
@ 14.09.15 @
19:30 - 07:15
¥ o0 0°
o Hof SH, Miinster
Q 15.09.15 recorded 10.06.16, 22:37:02
19:30 - 07:15
O — analyzed 23.06.16, 12:22:01
O 09.09.15 results 23.06.16, 12:24:31
19:30 - 07:15
+ v use relative file paths 1/594 sessions - 1/16 recordings E E Q

3.3. Data structures

Before working with bcAdmin it is important to understand its concept of data manage-
ment. The basic unit in bcAdmin is the Session. It includes the recordings of one device
and one night. This data container is used throughout the program for calculations of
activity and all data should be organized that way. You can group sessions in Projects for
getting a better overview. Within a Session recordings are collected. To keep the database
performant, the recordings themselves are not stored in the database, only meta-informa-
tion and a link to the file is included. The recording files are kept outside the database
on your hard disc. The same accounts for the measurement files (.bcCalls, .csv and .res
after batldent was run), these are stored also on disc, parallel to the recording files in the
same folder.
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So after importing recordings into bcAdmin, you should not delete the files. Each
session keeps a link to the path of the recordings. This file location can be changed if
files are moved for example from internal to an external disk. We chose this system, since
then you can easily backup files and other applications like bcAnalyze can easily access
the recordings and related files.

After importing and analysing the recordings you could delete the recording files to save
disk space. While that is tempting, we recommend to not delete these files, but maybe first
back them up. bcAdmin offers to archive the files of If later new tools allow better analysis
you can re-analyze your data. In addition to Sessions and Recordings other objects like
Locations and Projects are stored within the bcAdmin database. Sessions can be connec-
ted to these objects and thus be grouped.

To import results bcAdmin holds a list of all species results of batldent. A complete over-
view is given in the Taxon-Editor of bcAdmin. There you can also change display colors for
selected species.

Apart from recording relevant entries (session, recording) additional objects can be cre-
ated and stored. These are projects, taxa, location and environmental data (including for
example wind measures and temperatures).

l l

Session Location
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4. Creating database entries

As mentioned above, information is organised in Session, Project and Location objects
within bcAdmin. When importing recordings and thus creating a new session, the addition
of a project or location is not necessary. It can be done later on as well. Nevertheless, to
utilise some functions, locations are necessary. We thus recommend to not be too lazy, but
keep your database up to date. Sessions can be connected to locations and projects any
time. The following chapters will shed some more light on the data structures and show
how to import data easily.

I Filter I I Projects I l Locations I Environmental data

Session

I
Recording | i Species | Taxa

If the batcorder is used for a single or multiple nights for passive, stationary monitoring in-
formation for this location can be stored within bcAdmin. Note that bcAdmin is primarily
designed for working with data from one location per night, and thus not optimized for
transect data. Yet as explained in a later chapter, it can be used for mobile sampled data
as well.

Usually a location is connected to a session. To create new locations or modify existing
ones choose Window -> Locations and a window opens. There you get a list of all avail-
able locations. In addition you can filter locations and edit selected locations. For referen-
cing a location throughout bcAdmin it needs a name and entry for closest city. You can
copy and paste locations using the standard shortcut cmd+c and cmd+v.

Coordinates can be added in decimal degrees (WGS84). Using these coordinates bcAd-
min can calculate for example sunset and sunrise times. They can also be acquired from
the map. Choose ,Set coordinates from map“ and then mark the location by right clicking
within the map. Next save the coordinates and proceed as usual.

This function gives a graph showing sunset and sunrise times. It may be useful in planning
batcorder timer setup in advance. It needs coordinates to be set for the location.
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bcAdmin 4 has a new feature. It creates a central database per Mac user and uses in-
formation on location and taxa stored there as default when creating new databases. To
add locations to the central store you can select one or multiple in the location editor and
copy them to the central store. You also can import from the central store. To view the
central store choose from Window menu the command Shared locations.

4.2. Projects

Projects offer the possibility to organise your sessions similar to your work projects. Pro-
jects are shown and maintained in the leftmost column of the document window. Per right-
click or with the +-button (window bottom) projects and groups can be created.

Next to each project a number indicates the number of sessions contained within the pro-
ject. After you have selected a project, the session table will reload and only sessions be-
longing to the project will get displayed. You can add folders for organising your projects.
Sessions can be assigned only to projects and not to folders.

Projects can create subgroups either dynamically or manually. These subgroups are a list
of all locations and flag states of sessions within this project. The default setting is that you
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have to manually initiate the subgroup creation via the context-menu of a project. You can
also set bcAdmin to automatically create these groups whenever the project groups is
opened. The subgroups will be used best for projects with either many locations or many
different flag states.

4.3. Taxon-Editor

The Taxon-Editor gives an overview of all species integrated into bcAdmin and their tree
like organization. It is taken directly from batldent and resembles the id process. For each
taxon entry colors as well as the group can be chosen freely.

Taxa are stored per database and can be independently edited for each database. The
taxa list can be imported from a .plist file or exported to a .plist file. The central taxon editor
can be accessed from Window menu using Shared taxa.

Taxon editor for document AG-Fledermaus-MS

Barbastella barbastellus %8

Mopsfledermaus Genus / species

Bbar Other scientific name

Chiroptera spec Common name

Unbestimmt

Spec. Other Abbreviaton

Myotis spp. 20 +
> Myotis Group

Myotis Myotini

Nyc/Ept/Ves spp g m Quick key cmd €  single number from 0 to 9
> Nyctaloid

Nyctaloid Nyctaloid . . .

Colors and image (used in graphics)

Pip/Hyp/Min spp 4 ©
> pipistrelloid ]

Pipistrelloid Pipistrelloid Group HEEM  Genus HEE  Species HEN

Plecotus spp #¥9

Langohren S .

Plecotus Other Species image in scatter plots (%)

Rhinolophus sp. - 3
> Hufeisennasen batldent identification

Rhinolophus Rhinolophus

ID step 1 ID step 3
ID step 2 ID step 4
[
Translate common names to o)
Export Taxa list Import Taxa list Close

_|._ —_ . v
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5. Typical workflow

5.1. Workflow overview

The following scheme displays the typical steps when working with bcAdmin:

raw, wav csy, beCalls
7 —

. . - Import
Manual import Create Session » recordings
Find calls Import
l results
Automated Logflle-Import - Sessions+
import ogiile-Impo g recordings

C

batcorder,
Batlogger

% A: Creation of Session and recordings. This can be done manually or, as recommended,
automatically via the batcorder lodfile.

% B: Finding calls and creating measurement files.

% C: Statistical species identification using batldent. Import of identification results in bcAd-
min as well as control of results. Data summarisation as well as raw data can be exported
in various formats. This step is only necessary, if you do not use the new CoreML based
identification tool built into bcAdmin4

bcAdmin manages and saves all entries and results for sessions and recordings in a data-
base file with the extension bca4sqgl. When creating sessions, adding recordings and run-
ning their analysis it will read/write additional files:

% recordings; audio files from your recorder

% LOGFILE.TXT; batcorder logfile with runtime informations logged by the batcorder

+ call files .bcCalls; time-frequency measurements of all calls of a recording

% measurements .csv; measurements taken for batldent id process

< result files .res; batldent result files
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The logfile is used for automatic import of recordings and their organisation in sessions.
The recording files are read when the call finder is started as well as when time stamps
and recording lengths are read in. If you store files on a slow medium or on a network
drive, the access will be slower than if stored locally or directly connected hard disk.

The call files are used to display the call preview in the File Browser and thus read
whenever a call display is required. Measurements are used by batldent which creates the
.res files for results import into bcAdmin. The best approach is to organise all files belong-
ing to a single session within their own unique folder.

For creation of sessions and import of recordings the best approach is to utilise the import
from logfile feature of bcAdmin. That way recordings are copied (if necessary) from SDHC
card, sessions are created and recordings added. All available information from the logfile
is automatically entered into the database. This means you get start and stoptime as well
as batcorder settings created within bcAdmin automatically.

The following entries of a session are created automatically when importing from lodfile:
% Session-identifier: batcorder filecode is used
% Sample date: start/stoptime and sampling time are taken as recorded by the batcorder
+ filelocation: filelocation is set to the folder the recordings are imported from or copied to (if
logfile resides on the sdhc card)
» batcorder-settings: the settigns threshold, posttrig-

ger, quality and critical frequency are set

L X4

o000 AG-Fledermaus-MS.bcAdmin4sgl

Logfile-Version 24
Mitt. Anzahl SMS-Versuche

Aufnahmen kopieren

Whenever a batcorder SDHC-card is inserted in the B | ccin Projck B Keinstaus B
computer, bcAdmin recognises it and activates the Standort | Kein Standort E
SDHC toolbar item in the upper right of the window. Us- a4 Sessions
ing this button you can import files or format the SDHC-
STADTLOHN_ 05.06.12
card.
3 STADTLOHN 06.06.12
When import is started the logfile is read and parsed. #s0-08s0
The results are displayed. For box or wind turbine kits , STADTLOMN 07.06:12

the average GSM quality is indicated (the number of

tries for sending are counted). If the Mac is connected

to the internet a check for firmware updates is done. If a : S -
. . . . . . [ Alle | 44 Sessions gewahit

newer firmware is available, the firmware version in the

Abbruch Import
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upper right is coloured red.

The import dialog list all extracted sessions in a table. For each session available informa-
tion are shown. In addition a symbol indicates the usage mode of the batcorder and gives
hints if cards were full or battery empty:

. AUTO mode )\ wind turbine kit

AUTO+TIMER mode ® box extension
A logfile problem

If a logfile problem was indicated for some sessions not all recordings may get copied. You
should check manually, if the recordings were copied completely. If such error occur regu-
larly, please exchange the SDHC card.

The dialog allows to select which sessions to import. You can additionally already set pro-
ject and/or location for all sessions. Since the files reside on SDHC-card, you have to set a
folder the files should be copied to before importing them. Note that we recommend to set
the option to create a folder for each session named after the sample-date. Check each
session you want to import using these settings and start the import. That may take some
time, depending on the number of files that have to be copied to disc.

If you have already copied your recordings to hard disc, you still can use the logfile import.
Note that the logfile and the recordings have to be located in the same way they were
found on card. If you introduced subfolders, the logfile import may not be able to find the
recording files.

You can start the import via Sessions -> Import from logfile. Next a file chooser dialog
appears and you have to select the logfile you want to use for import.

The procedure to import files is as described above. The only difference is, that you‘ll not
need to set a filelocation for copying files to. If you want bcAdmin to organise the file struc-
ture, you nevertheless can activate file copy.
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When recordings get imported that way, their timestamp is set from the file creation date. If
files were copied to hard disc, they may have received a new timestamp. If that is the
case, you can later extract the correct timestamp from lodfile.

Starting with bcAdmin 4 1.0.50 you can drag files from a Finder window and drop them on
a session. This will import the files if filelocation is not already set for the session or the
filelocation is the same as where the recordings reside on disc.

You also have the possibility to import multiple logfiles from within a folder tree. This
proves useful if you have collected data over a season from multiple devices and have
them stored on your hard disk already. This way you choose the parent folder within which
the various logfiles and recordings are located. bcAdmin will collect all logfiles int he folder
tree and show an import panel per logfile automatically. The folder tree must be similar to
this:

Parent folder ->

SD-card1 ->

Logfile.txtx

Recording folders (created by the batcorder)
SD-card2 ->

Logfile.txtx

Recording folders (created by the batcorder)
SD-card3 ->

Logfile.txtx

Recording folders (created by the batcorder)

While you can add Batlogger wave files manually there also exists an import analogue to
the log file import. Select folders with Batlogger recordings, created per night. You may
have to change the Batlogger settings to create a folder per night. bcAdmin will read the
Batrec.log in the root folder of these nightly folders and automatically create sessions for
each sampling night. The according recordings are automatically imported. bcAdmin will
always try to evaluate the batlogger .xml files created per recording. These usually contain
temperature and coordinates.

Note that a previous import of files to BatExplorer 2.0 will change the folder structure. A
regular import to bcAdmin 4 is then not easily possible.
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The command Sessions -> Folder import allows importing any existing folder structure
from your hard disk. If bcAdmin 4 finds a Lodfile.txt in the progress it will ask if to use it.
Otherwise all selected folders are checked for recordings and if any are found, a session
for import is created. Note that the folder import does not deep traverse through your
folder tree. Using the folder import you can import the selected folders at one level. Set-
tings for the newly created sessions can be chosen.

There may be situations when you can‘t use the automatic import of sessions and record-
ings. For example if you have a collection of non-related files or if you are using another
recording device that doesn‘t create a logfile. We recommend you setup a session with
necessary information and add recordings to it manually. That way you can use all or most
of bcAdmin features with these recordings.

Either press the create session toolbar item (the batcorder symbol) or choose Sessions ->
Add to create a new session entry. Also note that you can duplicate existing sessions to
get a starting point. It will have most of the source sessions details filled in already.

Note: Duplicating a session will neither duplicate the files nor the filelocation.

Next set a correct filecode or identifier and set the correct sample date. Also make sure
start- and stoptime are set. If necessary adjust the batcorder settings.

After you created a new session it should be already selected in the table of sessions. You
can then add recordings either via the toolbar item or via the Session or Recording
menu, or by dragging files from a Finder window onto the session entry in the middle table.
If there is already a filelocation set for the session that differs from the filelocation of the
added recordings you‘ll get a warning and the process is stopped. Please first set the ses-
sion filelocation to the folder the new recordings are located at. bcAdmin supports only raw
and wav files.

When importing recordings the timestamp in the database for each recording is taken from
the file creation date. This may have been changed due to emailing, copying or uploading
files. If you still have a logfile at hand, bcAdmin will be able to reset the timestamp from
there. For some wav recordings you will be able to extract recording time from the file-
name.
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After adding recordings initially the recording stable list only a few entries, but no informa-
tion on count of calls or species. Only after you initiated the search for calls, you will get a
number of calls found, if any were found. Also you‘re able to see calls in the File Browser
now. The call finder works on all selected recordings.

Tip: Select all displayed recordings by pressing cmd/3§ and A.

The algorithm to find calls and extract measurements is lightning fast, and unique. Most
settings for this algorithm are set to an optimum value, optimised for batcorder recordings.
Still, as user you can and should change the threshold according to your recordings, which
equals the sensitivity. The threshold, thus call finding sensitivity, can be set at various
places. Note the value is given as damping value in dB. Thus a value of -27 dB is less
sensitive than a value of -30 dB.

The basic setting is per session. So files of a single session will all be analyzed with the
same threshold value set for the session. You can also set a general application wide
value. That is used only, if you choose to ignore the session value. This can be set in the
application preferences. There you can also choose to use adaptive call intervals. This
feature allows to improve call measuring when echos and calls overlap. Often this hap-
pens with Nyctaloid calls and pipistrelloid social calls are detected. Setting an adaptive call
interval of factor 3 to 5 allows to solve this situation quite often giving better identification
results. At the same settings panel in preferences you can also choose a parallel call finder
which is quicker than the serial call finding algorithm. You may adjust the number of simul-
taneous operations there. In addition you can choose to search for calls in background,
thus you can continue working in the open database. We don only recommend this for ad-
vanced users.

Find calls
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5.6. Results-Import

Starting with bcAdmin4 1.4.2 you do not need batldent for classification anymore. bcAd-
min4 comes then with a built in classifier based on CoreML using updated reference calls.
You once have to activate CoreML usage within application preferences. The option is loc-
ated in the Call finder sheet. The following paragraphs are only valid if you want to use
batldent.

After a successful call search species identification using batldent can be started. You
need to have installed and setup batldent for this.

Either navigate from batldent to the folder containing the corresponding recordings or
right-click on the selected recordings and choose Identify bat from the menu. For this bat-
Ident has to be activated as service via the System Preferences of Mac OS X.

batident will create a res file for each recording and also add per call results to the bcCalls
file. That way you‘re able to see per call id results in the FileBrowser. To display the results
in the recording table, you‘ll have to import results for the selected files.

Another word on activating the service Identify bats:

To go directly to the system preference that maintains the list of services, choose within
bcAdmin -> Services and there choose Settings. A dialog opens displaying a list of
available services in the right column. Scroll down and check identify bats. Now bcAdmin
should be able to communicate directly with batldent.

In the recording details view you get various information for the selected recording. There
also a table is visible showing the species identified with batldent and imported into bcAd-
min. You also see the probability as well as the previous step in the id process. Using the +
button you can manually add a new or replace an existing entry. Manually added entries
get a probability of 0% so they can be identified again easily.

Art Pre Stufe -
02:47:10 0,485 2 Pipistrellu...
Pipistrelloid 0.76 0 markiert > = . r :47: 16_Pipistrely..
gepruft
unsicher >Merkliste .
— raw.
Sozialrufe B +| | — . "
A4 raw
aw Flge Arten hinzu, I6sche oder ersetze Eintrage der gewahlten Aufnahmen
+ 50,79899° 8,74562° m
Ehme 27,0419, 21:39:44 :‘:’v Neue Art Bbar K  wird ignoriert bei 3 Arten
.04.19, 21:39:
. £4 Art entfernen Mbart
analysiert  27.04.19, 22:06:17 < o
. Art ersetzen
Ergebnisse 11.06.19, 09:42:32 k Mbart mit  Mbart B
Pnat mit  Pnat <]
E Ppip mit  Ppip 7]
Plecotus mit  Plecotus B
Abbruch L
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Using Recordings -> Batch replace species entries for a range of selected species can
be removed, added or exchanged automatically.

Furthermore the species can be set using the num-
ber keys (1 to 0) as well as the number keys +
cmd-key. The corresponding species for each
number can be set in the taxa editor. The key as-
signments can also be displayed in the file browser
by pressing the k key. By pressing the number key
either in file browser or in the main window the exist-
ing species entry for the recording is written over. If
you want to add a species, you have to hold the alt
key . Using the key combination ctrl + O deletes any
species entry in the selected recording. These key commands give you the possibility to
correct identification results for multiple recordings very quickly.

5.7. Call display and File Browser

One of the new features of bcAdmin4 is a direct call display integrated into the main inter-
face. You can thus quickly see a sonagram and measured calls when browsing the table of
recordings. If multiple recordings are selected only calls are shown and the sonagram is
hidden. With multiple recordings you can click on one of the recordings and select this one
for detailed analysis. A small circled arrow in the top right of the call preview allows you to
switch back to the last selection. Holding down the shift key while clicking a recording in
the call preview will deselect this recording. That way you can quickly assign new species
based on calls of multiple recordings and can exclude single recordings within the selec-
tion beforehand.

20190708-WEIHER_OST-000068.raw 03:03:17 Pipistrellus Ppip 100
0 -— -— - 20190708-WEIHER_OST-000068.raw 03:03:17 3,36s 15 Pipistrellus  Ppip 100

- 20170604-APOGARTEN_-002240... 22:11:48 1,46s
= 20170604-APOGARTEN_-002241... 22:12:58 4,26s
- 20170604-APOGARTEN_-002242... 22:14:10 1,04s

@ @ O O i Max. frequency = j=———————— 100 kHz
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g . =

St S — — — -—H‘

1

Frequency bands Filled B
Color scheme Blue / Red a

mark files if multiple recordings are selected

("] ask if too many calls for display
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A right click on the call preview allows to adjust settings like maximum frequency in dis-
play, style of frequency bands apart other from settings. You can also define bcAdmin be-
haviour when more than 300 calls are selected for display. It can be set to not display call
numbers of 300 or more to speed up working with multiple selections.

Using the File Browser you can quickly display calls and an overview sonagram of selec-
ted recordings as well as a sonagram of single selected calls. Open the file browser using
the corresponding toolbar item or the command Recordings -> File browser. After select-
ing a recording in the main window the Enter key will also open the file browser.

In the newly opened window you see a display showing the measurements per call (fre-
quency over time; call intervals are cut-out) as well as an overview sonagram (upper
graph). This displays up to four seconds of sound (see preferences). Using the arrow keys
on your keyboard you can move up and down the recordings table and quickly scan your
recordings. If batldent already identified species, you can see below each call an entry

| NON ) BatchTestDatei-Browser
Bbar 888 = (il
Spec. ‘ [ I ‘
Myotis 30 |
Malc | | N | ‘ ‘| I “ ‘ Eser
Mdas #4 l'u “ L\h “p &U»W 1 l ! ~| ‘hw “h wum lw ‘p\ ¥
Mema 0 U0 e 0 Y At T A6 A AT T AT PR AL
Mmyo - _________________________________________
Mnat 82 — [ ) ( ) ( )
Mkm 85
Mbec 87
Mbart 386
Mdau #3
Nyctaloid 9
Enil
Ept
Nyctief
Nlas
Nnoc 5 \ "; i
Tten
Nycmi 8
Eser 7
Nlei 6
Vmur
Nyc S > Cursorfrequenz
Pipistrelloid 4 20170604-APOGARTEN_-002235.raw Start/Endfrequenz 60,8/29,0
Phoeh ") B = - |t < > Dauer 7,20

Misch

Dnin 1

displaying species and probability for this single call. Additionally the sounds are displayed
as sonagram above the calls. Intervals are shown as well in the sonagram. The sonagram
is always stretched to fill the window width.
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Note: The results should be read as per call results and not be interpreted as the id result
for the file. The results of each single call are accumulated and an overall result is calcu-
lated. What you see for the per call results is typical for statistical noise, thus species
showing up you may not have expected.

Navigation through recordings is possible using the arrow buttons as well as the arrow
keys on your keyboard. This allows you to screen a large number of recordings very
quickly. It helps to control the quality of identification and find sequences with social calls
or feeding buzzes. By clicking the play or speaker button below the call display you can
playback either in ten-time delayed mode or with a virtual heterodyne detector (also by

pressing p).

To the lower right a sonagram of the selected call
is displayed. The red line indicates frequency
with most spectral power. Sonagram parameters
are chosen based on call length and cannot be
changed. By right clicking on the preview call so-
nagramm you can change the colors of the so-
nagram. Using a mouse left click and hold you
can drag a measurement display to manually
measure call values.

Starting with bcAdmin 1.0.40 you can display reference calls. After right clicking on the call
display choose reference calls display.

[ ] [ ] bcAdmind_Demo.bcAdmindsglDatei-Browser
Bbar #8 Ppip 90
[EmSpec: \ () Ppip 78
¥ Myotis 3
Male ' I‘l A e A PP 10 E—
Mdas ¥#4 y \ i
Mema ‘ . . : Vmur 69
Mmyo ®¥1
Mnat %2 ( )
¥ Mkm %5
Mbec ¥®7
Mbart #6
Mdau #3

¥ Nyctaloid 1
Enil
Ept
¥ Nyctief

e &

X

Call 7
Call 6,3

Nnoc 4 Zu
Tten
¥ Nycmi
Eser 6
Nlei
Venur 9 kuhlii »  call57 >
Nyc < nathusii > call52 > B
¥ pipistrelloid 2 pipistrellus > Call 5,8 g xquenz 70,5/47,4
¥ Phoch pygmaeus > Call 5,8 »
Misch call 6,4 > o4
Call 6 g —_—
M »
»
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For quickly changing or setting a species for the selected recording, they keys 1 to 0 and
cmd+1 to 0 can be set to a species. That way, when manually identifying a species using
the file browser (or while working in the recording table!), you can quickly set its spe-
cies entry. If you want to add a species to the existing entry, you can press the alt key and
the corresponding number. The maximum number of three species per recording can not
be circumvented that way. In addition the key combinations m, ¢ and u toggle the marked,
checked and unsure state of the selected recordings. All key combinations can be dis-
played by pressing the k key. The taxa keys can be assigned per document in the taxa ed-
itor.
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6. Sessions

To allow a quick and simple working with the application, most data can be accessed and
changed easily. All session details are accessible easily after double-clicking a session
entry in the session table. A popup displays all session details and allows editing all in-
formation. More elaborate functions let you access the logfile, delete or add recordings
and remove location or project connections. These are accessible via the Session menu.

In a previous chapter detailed instructions were given on how to import sessions manually
or from logfile. Since not all settings for a session may be available at its creation time, it
may be necessary to add details later:

5.~ - — 20150823-HOHEGEEST -000467.raw 19.8 20:58:24  063s 2
Filecode HOHEGEEST._ 23.08.15 01.08.18 Neu J
P © 23.8.2015,20:30 @ 24.8.2015,06:45 I GMT 42 |
L = 23.8.2015,20:38 I & 24.8.2015,06:27 I Bear
p
@ | Hohe Geest, Miinster [T € €205 [T
5 —
Dateiablage
Promise Pegasus > Aufnahmen > AGFMS > 150823 a
p
p
L Temp. min/max | 12,8 ° 20,3° C Wind min/max Bft. Mond
p =
Regen Wolken Hohe Geest, Miinster | 1o
P Schwelle -30dB | Samplerate 500000 Hz ~ Qualitdt 20  Krit. Freq. 16
Posttrigger =~ 400ms <
p Vorh. Session Né&chste Session
16
Acliciows AF A~ 44 ar.an.80

Filecode: This acts as name of the session and forms a unique identifier together with the
date. Usually this set to the same value as on the batcorder. If you use other recording
devices, you can code a location or project here.

Date: The date the sampling began. Acts as sample date throughout the application.
Project: Sessions can be grouped in projects.
Status: Sessions can be marked with a status or flag.

Sampling from / to: Timestamp for start and end of sampling. Is used by some functions
for calculating activity indexes.

Editor: You can add the person responsible for data collection here.

Filelocation: At this folder all recordings and related files are searched for. By unlocking
this field you can change the filelocation, for example after the recording files have moved.
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Furthermore these details can be set per session:

Location: This dropdown gives a list of available locations to connect the session to. If you
have already chosen a project for this session, only locations already connected to ses-
sions of this project are shown. You can show all locations.

Sunset/-rise: Timestamp for sunset and sunrise. These are used for some graphs as well
as for some calculations and should be filled in after best knowledge. If a location with co-
ordinates was set these values can be calculated.

Rain, Temperature: Both types of values have no special input format and are currently
not used by other functions. They are more for your own reference. Since the batcorder 3
does automatic logging of temperature while recording bats, the values get extracted
automatically when importing recordings via logfile. You can get a graph showing the tem-
peratures over night. If temperature data is available a small icon with a thermometer is
displayed. This acts as button to open the temperature graph.

Comment: Any comment for this session can be added.

batcorder-settings: If you‘re working with the batcorder, your settings should be added
here. For other recording devices or file formats, the corresponding samplerate should be
set. Depending on the recording quality, you may adjust threshold and quality settings.

Selected sessions can be edited per double-click. Selection of multiple selection is pos-
sible by holding down ecmd key when selecting. If you want to select a whole continuum of
sessions, select the first, then hold shift key and select the last one. If more than one ses-
sion is selected, most actions operate on the multiple selected sessions.

After some time of batcorder usage you may find your list of sessions grown a lot. Thus,
finding sessions may get painful. bcAdmin offers some ways to speed up finding sessions.

Sessions can be sorted according to various criteria. Click the session column header and
select the sort parameter you want.

You can quickly filter sessions by type of session (auto, timer, ...) using the drop-down
above the session column. More complex filters can be activated in the left sidebar. You
create filters analogue to projects, thus by using the buttons below the sidebar. Filters act
dynamically, thus whenever activated by clicking, they perform their filter and filter from all
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sessions those that fit their predicate. After creating new sessions you will have to reactiv-
ate/reselect the filter to see changes.

When creating a filter you should give it a label first. Then you can choose from a variety of
fields that can be used for the actual filter process. An explanation of what you can use as
filter criteria for various field types follows:

Date entries: You can use filters with daily accuracy.

Strings: Most fields contain string values. Various criteria for filtering strings are available
including equality, difference, starting with, ending on etc.

Boole values: They can be set to wither Yes or NO, or 1 and O respectively.Fields like
marked or audited belong to this type.

Numbers: All values that resemble numbers can be tested for equality or smaller than,
larger than, ...

For some fields special ranges of values account:

Details: moon: The value for moon is listed as percentage in the session details. It is thus
stored as value ranging from 0 to 1.

Recordings: classification: Recordings can be classified according to four different
types. Standard is 0 = no classification. Other values are 1 = normal calls, 2 = social calls
and 3 = feeding buzz. Please enter the respective number when filtering sessions that in-
clude such recordings.

Above the filter criteria you can in addition choose how criteria are combined and used.
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6.3. Temperature data

If the same environmental data is connected with the selected sessions you can display a
temperature history. In addition file numbers or seconds of sound recording are displayed
as bar chart.
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The red line indicates daily maximum while the blue line shows the daily minimum temper-
ature.

6.4. Archive sessions

A new feature of bcAdmin 4 is to archive sessions. This will create a zip of the session file-
location and is useful to save space on hard disk. It only works well if per session a single
folder exists and the files are not used by another session as well. You can archive the
selected sessions using the menu Sessions - > Archive session files. Archived sessions
are displayed with blue color in the session table. If the zip file stays at the location where
it was created bcAdmin can still extract sound files and call values from the archived files
for display. Only changes that create new files are not possible anymore.
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The correct filelocation is important to find the files belonging to a session. They are
needed when searching calls as well as when displaying call displays. Sessions with a
missing filelocation or an invalid filelocation are shown in red in the session table. When
you are moving a folder with recordings, the sessions pointing there will be drawn in red.
You then have to adjust the filelocation, otherwise the files can‘t be accessed from bcAd-
min. If you have to adjust the path for multiple sessions, bcAdmin will help you as much as
it can. It will first determine the common path of all sessions. As long as you have stored
and moved recordings in a parallel way, so not randomly, this should be good enough.
bcAdmin will allow you to exchange the common old path with the new filepath the ses-
sions have in common.

An example:

Sessions with FILECODE_A, FILECODE_B and FILECODE_C store their recordings in:
/NVolumes/Macintosh HD/User/batcorder/Recordings/130601

/NVolumes/Macintosh HD/User/batcorder/Recordings/130605

/NVolumes/Macintosh HD/User/batcorder/Recordings/130610

The common path thus is:

/NVolumes/Macintosh HD/User/batcorder/Recordings

If you move these folders to an external hard drive as follows

/Nolumes/EXTERN/Recordings2013/130601
/Nolumes/EXTERN/Recordings2013/130605
/Nolumes/EXTERN/Recordings2013/130610

That way the old common path from above will be exchanged with:

/Nolumes/EXTERN/Recordings2013

This method of path replacement is always possible, if multiple sessions are selected
when the session details are opened.

Manual bcAdmin 4.0 Version 1.4.3 - Page 26



6.6. TSL-evaluation

The microphone test recordings of box and wind turbine extensions as well as the GSM-
batcorder can be analyzed to check for correct microphone sensitivity. For this test the re-
cordings have to been imported using logfile import from SDHC card. That way the micro-
phone test signals are specifically labelled and can be accessed automatically from bcAd-
min. The plotted graph shows the results of RMS measurements within the test signal.
Since the reference value taken when implementing the batcorder in the field is not known
to bcAdmin, you have to read the graph by looking at the average RMS. From the average
two lines showing- 3 dB and- 6 dB are plotted in yellow and red. Values outside the -6 dB
range indicate mic problems.
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6.7. Combining sessions

This feature allows to combine two session in such a way, that duplicate recordings (based
on time stamp) are removed int he resulting combined session. This for example is useful

when you have recorded at two similar and close
locations and want a combined dataset of bat activ-
ity. Usually this feature is used with a selection of
multiple sessions. These must reside in one project.
The other set of sessions, mirroring the first set by
days, must be inside another project. The combina-
tion dialog after selecting the first set of sessions
then allows to choose the project with the second
set. You can also choose the time interval allowed
between two recordings to still count as one pair.

Gewahlte Sessions im Projekt

Vergleichen mit Sessions in

€ Woche 2 B

Sessions aus Vergleichsprojekt hinzufiigen, wenn Hauptprojekt ohne Session

Ergebnisse speichern im Projekt

Aufnahmen innerhalb des Zeitintervalls
kombinieren

Arten bei Kombination ignorieren

€ Urlaub gesamt a

Sekunden

Aufnahmen innerhalb des Intervalls mit verschiedenen Arten werden

ignoriert und nicht zum Ergebnis hinzugefiigt.

Abbruch

For running the combination you best have third project that is empty.The new sessions
are created in this project. The newly created sessions are marked by a C- in front of the
original filecode. Virtual recordings, that mean those added from the second session set

are displayed in italic.
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6.8. Comparing sessions

Another feature for working with larger datasets is the session comparison tool. It works
with two up to four single sessions as well as a batch mode for sessions organized in pro-
jects. It allows to visualize activity identical as well as different in time between various

sessions.
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7. Recordings

There are many methods in bcAdmin making management of your data easier. While most
information is stored within the database for fast access, the raw recording files and all de-
rived files are saved at the sessions filelocation. Some of the following functions need ac-
cess to the files to work properly. Others can work on the database alone.

7.1. Recordings table

The main interaction with recordings is done using the recording table in the main window.
This displays apart from filename and recording time many other meta information for each
recording. Using the application wide preferences you can choose visual display of
marked, unsafe or audited recordings. In addition the preferences allow to colorize all re-
cordings belonging to a single time period defined by a choosable time interval. Apart from
activating this feature in the preferences the table has to be sorted by recording time.

Cla.. Marked Audited Uncert.. Filename Time ~ Dur Calls Genus Species Tem... Count Wind.. Comment
0 - - - 20200731-SUNNENBARG-000359.wav 21:58:46 1,79s 15 Barbastell.. Nyctaloid 70, Bba... 2
0 - - - 20200731-SUNNENBARG-000360.wav 22:02:28 1,65s 12 Pipistrellus  Ppip 100, Pnat 0 2
0 - - - 20200731-SUNNENBARG-000361.wav 22:04:06 2,40s 14 Nyc/Ept/Ves Nyctaloid 86 1
0 - - - 20200731-SUNNENBARG-000362.wav 22:04:44 13 Eptesicus 1
0 = = o 20200731-SUNNENBARG-000363.wav 22:04:56 2,98s 17 Nyc/Ept/Ves Nyctaloid 69 1
0 - - - 20200731-SUNNENBARG-000379.wav 22:17:24 1,31s 9 Pipistrellus  Ppip 100 1
o Vv = =  20200731-SUNNENBARG-000384.wav 22:25:28  3/16s 27 Myotis Mdau 51 1
0 - v - 20200731-SUNNENBARG-000385.wav 22:25:40 0,67s 1 Chiroptera  Spec. 0 1
0 - - v 20200731-SUNNENBARG-000386.wav 22:25:48 1,29s 10 Chiroptera 1
2 = = = 20200731-SUNNENBARG-000388.wav 22:26:20 117s 6 Pip/Hyp/Min Pipistrelloid 29 1
0 - - - 20200731-SUNNENBARG-000389.wav 22:26:36 0,67s 1 Chiroptera Spec. 0 1
0 = = o 20200731-SUNNENBARG-000390.wav 22:27112 0,78s 3 Chiroptera  Spec. 0 1
0 - - - 20200731-SUNNENBARG-000393.wav 22:28:36 0,99s 4 Chiroptera  Spec. 0 1
2 — i — 20200731-SUNNENBARG-000394.wav 22:28:58 1,40s 11 Pip/Hyp/Min Pipistrelloid 33 1
Y = = = 20200731-SUNNENBARG-000395.wav 22:29:00 0,91s 2 Chiroptera  Spec. 0 1

On right clicking the column headers you can select or deselect columns to alter the table
display.

7.2. Recording details

The recording details allow to set details for each recording entry in the database. You can
open the detail view by by clicking the small buttons in the lower right of the recording
table.

Art Pre Stufe
Ppip 0.68 Phoch 0.8a |  markiert > |m| |\
geprift
| unsicher >Merkliste
ohne Klassifizierung E —+
e:) Standort wahlen <
* o 0°

Aufnahme 27.05.14, 23:27:02
analysiert 05.06.14, 11:10:20
Ergebnisse 05.06.14, 11:10:48
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Each recording entry can be classified as normal sequence, social calls or feeding buzz.
Apart from social calls of pipistrelle this will not be done automatically, but can only be
checked manually. The comment field can be used for any kind of comment liek for ex-
ample your own guess regarding species.

Note: classification and comment can be set only for the whole recording entry, not for a
single species entry.

Using the mark checkbox you can mark a recording to find it again easier. A checkmark for
audited means, the recording result was manually controlled. There also exist buttons to
open a file in Finder, with a sound tool like bcAnalyze or in the call preview of the file
browser.

Simply by clicking the columns headers the whole table can be sorted using the column. In
addition you have the possibility to filter using a couple of criteria listed above the record-
ings table:

® [ ] privatMR2019.bcAdmindsq|
o+ + »
Neue Session Aufnahme hinzufiigen Artenliste Artenbaum Nachtgrafik Jahresgrafik
0 1 2 3 Markiert Art v Gattung/Gr... v Klassifikati... v Wahr. v Benutzer Q
ALLE SESSIONS Sessions sortieren... v Kla.. Marki.. Geprift Unsich.. Dateiname Zeit A Dauer Rufe
WEIHER_OST 08.07.19 0 - - — 20190427-MR_2019XXX-000788.raw 20:42:48 0,87s 0
ALLE AUFNAHMEN 21:54 - 05:56 m 0 = - - 20190427-MR_2019XXX-000789.raw 20:43:29 0,87s 0
— — - 20190427-MR 2019XXX-000790.raw 20:48:12 0.87s 114

Mark.: only marked (see recording details) recordings are shown, the control switches to
Unsafe, Audited and negation of these with consecutive clicks.

Count 1/2/3: only recordings with the according number of species are shown
Species: Only recordings with the selected species are shown

Group: Only recordings with the selected group entry are shown

Class: only recordings with the corresponding classification are shown

Prob: only recordings with the corresponding probability are shown

Custom: custom filters allowing to filter by recording time and other values
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Note that the filter stays active even when you

Nyctaloid v  Gattuna/Gruope v  Klassifizierung ¥  manuell v

select an other session or dataset. Active filters .o Nyve manuell v |Kine |Markl.. |Gepriift | Unsich.
are indicated by a red background of the filter | Filterspeichen  AJRL} o - - v
. . Filter bearbeiten 415 0o - = v
bar. You can remove all filters using the x button TE— . :
. . 3/Gruppe v Klassifizierung v manuell v Benul
on the right end of the filter bar. o,
The filters can be saved by right clicking on the colored filter Bestehende Filter :
bar and choosing to save the current filter. Saved filters are | Wvemanuel B |
available throughout all databases and can be deleted again Filter Iéschen '
| |
by choosing to manage the filters. Abbruch Nutze Filter |
|

A we —

The additional custom filters are available by clicking on Custom in the filterbar. These al-
low certain filters based on recording time. For some the sessions need to have set correct
sunset and sunrise time entries. These extra filters are useful when dealing with large
datasets from long term monitoring as for example from wind turbine assessments.

yort results File browser Species list Species tree Night graph Year graph Correlator
us/Group v  Classification v  Prob. v m fx]
v C Time A~ Dur (
— Recordings at night with twillight 1 hour 2rogae 179
15,0450 ecordings at night wi willig ou h-J 22:02:28 1655
m Recordings at day with twillight 22:04:06 2,40s
; - 22:04:44 1,61s
19.04.20 Sunrise / sunset +0.5 hr -0.5 hr 4 22:04:56 2,08s
: _ 22:17:24 1,31s
Recordings between 15:00 and | 10:45 .
a5 - o o 22:25:28  3,16s
19.04.20 Call count > < 1 22:25:40 0,67s
22:25:48 1,29s
m Analyzed after H 8. 2.2022 ¢ 22:26:20 117s
22:26:36 0,67s
19.04.20 after 8. 2.2022 ¢ ’
D bl after &9 22:2712  0,78s
Temperature > < 1 22:28:36  0,99s
20.04.20 : 22:28:58  1,40s
Windspeed | v | 1 22:29:00 0,91s
21.04.20 || N
: |
24 — NP NI
* e g by OIS /Ll b ) A% ey
A1 AAAA al .'"l IA.r" i A‘l!l"'l-\ LS Y l“ﬁ.f ' IV '.‘

Another new filter is based on measurements of each call. For this filter the recordings
must be available on disk as files and measurements have to be created by the call finder.
To activate the call measurement filters, you need to double click any entry in the Calls
column. In addition the filters can be activated from the menu Recordings -> Select call
parameters. Another filter in the recordings menu will filter a random number of record-
ings.
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Select recordings with calls having the following parameter
Dur [T

within lower and upper range

5,0 =t o= 10,0

within lower and upper range

. e S S S S S SR B

0 s> <= 0

filter recordings instead of selecting |

Cancel Ok

7.4. Managing recordings

You can delete recording files displayed in bcAdmin directly via the according menu items
in the Recordings menu.

Using Sessions->Add recordings or Recordings -> Add recordings new recording files
can be added to bcAdmin. They will be added to the current selected session. You can‘t
add recordings from different filelocations to one sessions, though.

7.5.Feeding-buzz detector

We do not believe that feeding buzzes are a reliable marker for hunting behaviour - or the
absence of feeding buzzes for no hunting behaviour. Yet bcAdmin 4 features a detector for
feeding buzzes in selected recordings. It is available from the Recordings menu.

7.6.Find trigger events

Sometimes you have recordings covered by a lot of artificial noise or bushcrickets. In such
situations the call finder may not be able to find all calls. Using the trigger finder may allow
to find some more recordings with positive trigger events that were not good enough for
the call finder.
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Starting with version 1.3.5 bcAdmin 4 includes a parasite noise detector. After call search
and batldent identification at some locations you end up with many Spec or Pipistrelloid
recordings that are actually noise. The process of checking these can be cumbersome.
We have included an automatic tool based on machine learning. Select the relevant re-
cordings and choose from the menu Recordings the option Detect parasites. Each record-
ing will be classified as Bat or ,Stérung® (German for noise) and the result is written to the
comment field.

If you have recorded noise/parasite that the supplied method does not recognize as noise
you can learn an adapted model. For this select the relevant recordings first. Make sure,
they do not contain bat calls apart from parasite noise. From the Recordings menu choose
to Export parasite (requires macOS 12). Using the application CreateCallsModel (down-
load on our homepage), you can create a custom parasite detector including our data as
well as your noise data. The resulting model-file can now be used as an alternative to the
built in classifier model. To use your own mode hold the shift key when starting the para-
site detector from the recording menu. You are then asked to choose your model file which
is used for the parasite detection then.

In bcAdmin4 1.4.0 we have introduced a new species identification tool which will replace
batldent this year. The first version is preliminary and does for now store its results in the
recording comment. That way you can easily compare batldent results and CoreML res-
ults.

The classifier is found in the recordings menu and you can either classify on genus/group
level (only the first classification step) or on species level. The command takes the selec-
ted recordings and is doing an analysis. The process is ca. 5 times faster than the batldent
process, with higher speeds on the optimized Apple computers with M processors.

For optimal results of the new CoreML classifiers we recommend to adjust the call finder to
eliminate such calls deviating from the regular calls. This can be activated in the applica-
tion Preferences -> Expert settings. Choose to filter noise using statistical analysis and al-
lowing only such calls with a median as criterium within 100% bandwidth.

Since version 1.4.1 a new feature was added. In Preferences -> CoreML you can set indi-
vidual probability thresholds for genus/species which must be met to add a call to results
and output a final result. For a better understanding of these thresholds we explain in
short, how the classification process is working and where these probabilities are effect-
ively used.
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1. Classification on genus/groups level: In a first step for each call the genus (group for
nyctaloid calls) is evaluated. The classifier gives a result and a probability. If the prob-
ability reaches at least the threshold set for the result (standard 0,8 = 80%) the result is
stored for this call. If the criterium is not met, unspecified Spec is stored.

2. Classification on species level: The next step classifies the call on species level. The
classifier again gives a result and a probability. If the probability reaches at least the
threshold set for the result (standard 0,8 = 80%) the result again is stored for this call. If
the threshold is not reached, the last result (genus/group) is kept.

3. Final result for recording: The results of all calls are combined per genus/species are
sorted by probability and count. For each result the probability must reach the threshold
to qualify as final result for the recording. These results are then reported.

The preference window gives two fields per genus/species holding the single call threshold
in the first and the overall threshold in the second field.

In bcAdmin4 1.4.2 the results can now be directly used instead of batldent results. You
only have to activate this option once in preferences -> call finder. There you can opt-in to
still produce the csv-files used by batldent. The new CoreML classifier works without the
csv files as well.

If your detector has a known sensitivity you can calculate the distance the calling bat had
to your detector by assuming a call amplitude for the bat. Using this tool will not give exact
distances to the calling bat, but it will help to estimate the range you were recording the
bats at. You start the distance finder from the Recordings menu using Plot distance.

00 CacheTest.bcAdmindsql

source dB SPL @ 10cm 120 detector dB at full-scale
50,0 ;

45,01
400°
350°
300°
250°

Distance

20,0
15,02

10,0}

=
i

501

0,0°
21 22 23 0 1 2
Hour

Close ®© 21|C] 2|[C Save image
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For the batcorder you can assume 96 dB full scale at 40 kHz when properly calibrated. If
your detector of another brand is calibrated, you should have a value for full scale as well.
Bats can be expected to use sound pressure levels of 90 dB (whispering bats) up to 130
dB SPL.

The timestamp for each recording is extracted from the file creation timestamp when the
files are imported to bcAdmin. This timestamp may not be correct if the files were copied,
sent by email or otherwise moved between different media. Thus it may be necessary to
change the timestamp to the correct one. Various commands exist for this task. You can
use Recordings - Adjust recording time to add or subtract a certain amount of hours,
minutes and seconds to the current timestamps. With Recordings -> Adjust time from
logfile the logfile is read and timestamps are extracted from there for each recording. Fur-
thermore a feature exists for SM2Bat and Avisoft recordings that store the recording
timestamp in the filename.

You have the possibility to simulate a batcorder with different settings based on the selec-
ted recordings. This enables you to switch parameters if you have mistakenly used differ-
ent settings when recording. Note that only some simulations are possible:

Posttrigger | >= Posttrigger e.g. 600ms batcorder vs. 200ms simulation

origina simulation

Threshold | =< Threshold e.g. -36 dB batcorder vs. -27 dB simulation

origina simulation

The results are stored using virtual recordings in your session indicated by italic print of file
name. All other aspects like duration, species etc. are copied from the original recording.

Selected recordings can be exported as wave files using Recordings -> Save as Wave.
This may be useful if batcorder files have to be sent to someone not being able to open
raw recordings. The exported files get the timestamp of the database entry.
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8. Managing environmental data

When analysing bat activity environmental parameters like temperature or windspeed
influencing the activity are often of interest. In bcAdmin4 these can be imported and stored
in the database as extra objects and then be used for various analyses. You can open the
editor form the Window menu using Environ data.

O CacheTest.bcAdmindsql - Environmental data

BLUM2-Daten 2018-+0100
BLUM2-Daten 2018-+0300
ETT_BC_1.1-2020

Ettelried, Ettelried
FF3MR_H54_2019
HB10___-2020

P2416 WEA04-2019
P2583WEA01-2020
P2960WEA01-2020
SUED_GAUTI-2020

TEST

TG3______-2020

Yy vV v v v v v vy v.v.v v

Year graph

Close Import

Administrate and import environmental data from there and store windspeed, temperature,
rainfall, energy and coordinates within a single dataset. Coordinates are managed from
the maps view where they can be used for geo referencing. When importing from lodfile,
the stored temperatures from the batcorder are imported as environmental data and stored
with the according FILECODE. Simple analysis allow to see time gaps in data as well as
various statistics.

The import of CSV files is one of the main tasks of the environmental data editor. If you
want to add data to an existing dataset, choose the main dataset in the first column, then
use Import. Otherwise a new main entry is created. After choosing the csv file for import
next choose the appropriate settings to import single columns and timestamps from the
CSV file. Display of either raw data or a table is possible indicating by bold text the
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imported data. Note the correct time format as well as the deviation of GMT for the data is
needed.

| CacheTest.bcAdmindsgl - Environmental data

CSV file /Users/Shared/Testcases/bcAdmin4Tests/Curtailement/WEA1163_cut-in... Choose file

m Tabular display

Monat;Nachtzeit;CutinWindgeschwindigkeit; Temperatur
4,0-0,1:4,1;10
4,0,1-0,2;4,6;10
4,0,2-0,3;4,3;10
4,0,3-0,4;4,3;10
4,0,4-0,5;4,3;10
4,0,5-0,6;4;10
4,0,6-0,7;4,1;10
4,0,7-0,8;3,7;10
4,0,8-0,9;3,5;10
4,0,9-1;1,4;10
5;0-0,1;4,9,10
5,0,1-0,2;5,3;10
5:0,2-0,3;5,1;10
5;0,3-0,4;5;10

CSV properties

line ending Windows (CRLF) |4 Field seperator | ; |4 decimal separator A

column titles in line 1 7

Data properties

data column Timestamp Nachtzeit d DST/T (GMT+1/2) |
CutinWindgeschwin... |2 | time in next column
Date format Select a date format d
Close Import

.| CacheTest.bcAdmindsgl - Environmental data

You can examine various properties of the

data like time gaps, minimum and o,
maximum as well as the distribution of H

Winds|

data by using the various buttons.

Close Save CSV ... | v | Save image

Close |7 Histogram T™ Delete T Import [T Save CSV ...

v
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9. Data analysis

bcAdmin contains various tools to analyse your data for different goals. You are able to
create meaningful activity summaries and graphs for your reports. Usually the following
tools work on data of the selected sessions.

9.1. Species list

This feature gives a list of all species encountered at the selected sessions. Additionally
sessions can be summarised based on various parameters. Based on averaged probabilit-
ies bcAdmin creates a probability for each species/group entry and indicates this with dif-
ferent symbols. The basis is a weighted average over all species entries. Species with only
a few entries may thus be more easily classified as of lower probability. The result can be
saved as image or CSV file.

000 AG-Fledermaus-MS.bcAdmindsglArtenliste
Daten zusammenfassen Datum | < |
Taxon 17.09.14 18.09.14 20.09.14 21.09.14 22.09.14 23.09.14 24.09.14
Beschreibung 17.09.14 18.09.14 20.09.14 21.00.14 22.09.14 23.00.14 24.09.14
1 session 1 session 1 session 1 session 1 session 1 session 1 session
¥ Myotis - - - - - - =
Mdas - - ¥ - - - -
¥ Pipistrelloid -~ o o — o~ o
¥ Phoch - - - - - - -
Ppip L] L] L] L] L] ® .
¥ Ptief - - - - - - -
¥ Pmid - - - - - - =
Pnat L] . - > . L ] ¥
¥ Nyctaloid = = = = = = =
¥ Nycmi - - - - - - -
Eser . » = = = = =
Nlei - L] ¥ o i - —
¥ Nyctief - - - - - - —
Nnoc . - » . - L] .
Plecotus - - - - - - —
Aufklappen Einklappen CSV speichern... | v Bild speichern Wahrscheinlichkeiten
SchlieBen

9.2. Activity report

The activity report is a powerful tool for comparing the data of various sessions or sample
efforts. You create an activity report using Analysis -> Activity report . The report lists
after its initial run for each selected session a column and a row per species/group entry.
Sessions can be grouped using date, project or location entries. Data can be summarised
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in form of count of sequences, recording durations in seconds as well as activity in one-
minute classes. Some entries can be normalised based on sampling or night duration.

000 AG-Fledermaus-MS.bcAdmindsqlAktivitatsbericht

Ebenen Kirzel | T | Anzeige Wochen | < Aktivitdt als Aufnahmen | T Mittelwert keine Mittelwerte |7
Taxon 22 2 24 2 2 27 2 29 3

Eser 0 55 84 24 63 39 26 49 53 13 30 2
Mbart 0 0 0 0 0 0 0 0 0 0 1

Mdas 0 0 0 0 0 0 0 0 0 0 3

Mdau 0 0 0 0 1 0 0 0 1 1 1

Mkm 0 0 1 0 0 1 0 0 0 2 3

Myotis 0 0 1 0 0 0 0 0 0 0 0

Nlei 0 0 6 3 0 0 5 5 38 12 1 1
Nnoc 3 7 5 20 22 18 14 25 33 2 36 2
Nycmi 0 8 6 2 0 0 1 1 0 0 1
Nyctaloid 5 6 12 3 1 0 0 1 0 0 1

Phoch 0 1 1 15 0 0 0 0 0 0 0
Pipistrelloid 0 0 2 9 0 0 0 0 1 0 0

Plecotus 0 0 0 6 0 0 0 2 2 0 1

Pnat 7 10 10 18 18 8 13 25 57 14 13

Ppip 271 443 714 1.991 1.003 553 829 1.157 2162 562 3.449 1.29
Ppya 0 2 0 21 2 0 2 1 0 0 1

SchlieBen CSV speichern... [V Grafik

The following activity indices are implemented:

% Seconds: The activity of each species per second (recording duration) is calculated

% Sequences: The number of sequences

% 1-minute classes: for each minute of sampling time with activity the minute count is in-
creased. Thus, all sequences of the same species recorded within a minute count as one.
Sequences that have a timestamp outside the sampling time are ignored. Thus check that
session settings are correct before using this function.

% Free time class: You set in preferences your time interval for combining recordings

% Continuity: If multiple sessions or locations are combined (for example monthly activity),
the continuity gives a measure of how regular activity occurs. It ranges from 0% (none) to
100% (every session).

| addition all calculations can be averaged based on hours of sampling, nights, etc. using
the popup button in the upper right.

For some of the above calculations suntimes and sampling times from the session entries
are used. Make sure these are set correctly, otherwise you may receive wrong results.
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The displayed results can be exported to a CSV file for import to graphing apps or other
databases. The standard setting is that the table will get transposed for export, but you can
switch that off in the app preferences. HTML export works the same and creates a HTML
preview for printing or saving.

A new function to bcAdmin 3 is the graphical display of results of the activity report. After
selecting the report options a simple bar chart can be opened using the button Show
graph. When opened the first time it displays the sum of seconds of each column in the
report. Clicking on settings opens a dialog that gives options like species selection. That
way you can select certain species for display in the graph.

Pr

o0 AG-Fledermaus-MS.bcAdmin4sqlAktivitatsbericht
ES 400,0 7 Weser  [lmoat  [Imdas []mdau e
1 DMkm .Mvotis .Nlei |:]Nnoc
Te T
1 Dchmi .Nyctaloid DPhoch -Pipisuelloid
n
B¢ 1 W recous [Mrnat [ rova [l soec.
a 300,0 | 3
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M T
M - T
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w | S 2000}
{ £
NI > 1
< 1
Nt 2
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Pt 100,0 +
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SchlieBen Einstellungen Bild speichern

The species colors are taken from the values set in the taxon-editor. If you want or need
other colors, change them there for the whole database.

9.3. Species tree

The species tree displays the distribution of species identification for the selected ses-
sions. It resembles the steps batldent went through to find species for the recordings. You
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can opt to display number, seconds or minutes of activity per tree element. The numbers
are also coded using either small bars or pie charts, you can chose between those two
displays. In addition the average probability for each tree element can be plotted. The
graph works well for showing diversity as well as for finding identification errors by looking
at the numbers shared between similar calling species or groups.

(XX ] AG-Fledermaus-MS.bcAdmin4sqlArtenbaum

6 session(s) selected

162

Myotis Nyctaloid Pipistrelloid Plecotus

s
&
@
8
&
&

Anzeige: Anzahl Aufnahmen 3303

SchlieBen Bild speichern Aufnahmen [ — ¥) Wahrscheinlichkeiten

For various reasons it may be helpful to examine activity at a location throughout one
night. Emerging patterns may indicate roosts, or other bat relevant structures. For single
as well as multiple sessions bcAdmin offers the display of nocturnal activity. It can be ac-
cessed via Analysis -> Nocturnal activity after the relevant sessions were selected.

Activity is displayed as bars in a histogram like way. The bats can either represent number
of sequences or seconds of activity per bin. You can adjust the bin width from 5 to 60
minutes. The background can be filled to indicate night or sampling duration. To allow bet-
ter comparisons of different nights, you can also set the displayed time frame. Single spe-
cies can be plotted as sub-bars by clicking the eye symbol next to their name in the left
column. Finally the display of either species, genera or groups can be toggled. For export
a legend can be toggled using the small legend icon in the upper right (only visible if spe-
cies are coloured). A right click on the graph shows a context menu with options to set a
maximum y-axis value as well as graph subscription.
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o000 | AG-Fledermaus-MS.bcAdmin4sqlN&chtliche Aktivitat
O Ale Cale  Meoio [ Maas
©  Ppip l:l Nnoc . Pnat . Eser
© Mdas - _ )
© Nnoc 200,0 .Plecolus .Plplsuellold . Nlei
© Pnat
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© Nei 1500
=
o
1
<
Zeige Werte s
SN sekunden  Minuten 2 1000
Balken 10 minutes
Daten zusammenfassen
50 Gattung  Gruppe 50,0
| Nachtdauer
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"110% classes
gestapelt 00
Stunde
SchlieBen Bild speichern CSV speichern ... “ [ Legende © |20(//| 6] [C
9.5. Yearly activity
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SchlieBen Balkenbreite 5 min E Einstellungen Bild speichern

If you are doing long-term monitoring your interest often lies in the activity pattern through-
out the year. This feature allows you to take a closer look at bat activity distribution split
into daily and nightly patterns within one graph. It works for the selected recordings, thus
you can easily display graphs for single species or all recordings. It is not meant as a
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graph to read accurate maxima and minima, but to give an overall impression of activity
patterns. To draw the graph select Analysis -> Yearly activity after you have selected
sessions and recordings. For better understanding of patterns the batcorder runtimes can
be displayed in the background. They are taken from the session settings. Based on the
coordinates sunset and sunrise are drawn as lines. If no location with coordinates was giv-
en to the sessions, a standard mid Germany location is assumed.

The sliders below the graph allow to change the color fill similar to a sonagram. To re-
semble a sonagram even more, you can activate a sonagram-like display as well. Export
to an image file for adding the graph to reports is possible as well.

These two plots show the distribution of activity over night. One displays the batldent
probabilities for each recording, the other shows a selected frequency parameter for the
selected recordings within the night. Both graphs help to identify possible misclassifica-
tions and overall give an impression of identification sturdiness.

The graphs can be manipulated in various ways. When holding cmd-key you can select
recordings by drawing a selection rectangle around measurements and zoom them full
screen. By double-clicking while holding down cmd-key the graph is unzoomed again.
When selecting measurements by a selection rectangle while holding alt-key, the record-
ings get selected in the recording table of the main window.

[ ] [ ] privatMR2019.bcAdmindsglFrequenzplot

Fi
NN s o o
s & & 8 &
s o s © ©

:te*u::!::rw
o060 O
o
cooooo
ooco
ooooo o
°
oo ° °
eo0e
wo
o0~ ©
oo o
o0 °
.
gz °
Lo gpoo
cocoo ©
oo o
es0®0. O
‘cooooooo

Fmod B Artfarbe %] Symbol-Grége  — © [20][2]| 6|2

SchlieBen Histogramm Legende Bild speichern

Another powerful tool to help identify misclassifications as well as to classifiy species your
self without looking at all single calls is the call parameter plot. In form of a classic scatter-
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plot you can choose to display two measurements, each on an axis. Typical pairings are
duration and Fmod (which translates roughly to mean frequency) or duration and Fend
(end frequency). Using the mouse while holding down cmd you can draw a selection rect-
angle to zoom in. Zooming back to normal os done by cmd+ double click. A right click on
the graph allows to display some reference measurements of a limited list of species.
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One of the most complex features impolemente din bcAdmin is the correlation of activity
data with environmental parameters, mainly wind speed. This tool was developed to un-
derstand activity in relation to wind speed better and support the bat-friendly running of
wind turbines.

[ X WEA1.bcAdmindsgl - Environmental correlator
Environmental datasets Use values stored with recordings
2019 Scada » Windspeeds Add environmental data
Scada-Daten WEAQ1 » Temperatures
batcorder > Reload data browser
Time zone adjust [a} Location for sun times = WEA-01, Ahnsen

Correlation Wind+Temperature scatters

Show gaps in the data Show data range and Validates the recording Export statistical data
timeline in a tabular or basic statistical values hours for plausability of environmental data
graphical display. Gaps for full dataset as ell as with Probat. per night as csv.
must be larger than 10 for night values only.

minutes.

Show time gaps Data stats Probat validation Per night export

Close

The calculations are based on the selected recordings, thus, first select the recordings you
want to run a correlation for. That way you can select recordings of all bats or of certain
species. If you select recordings without species entry, these will be correlated as well. Us-
ing the recording filter capabilities helps to select wanted recordings quickly.

Next you need to select the environmental dataset containing the data for correlation. If
you don’t have any imported yet, you can start the import here instead of in the environ-
mental editor. You can also opt-in to use data stored with recordings, for example after a
successful correlation.

You can do some checks on the environmental data before running the correlation. For
example can you check time gaps or see the stats of one parameter.
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4 Windspeed (m/s) Overall Night

Maximum 23,71 17,3 |
75% 6,6 6,72 )
Average 4,8814 4,8891 1
Median 4,22 412
25% 2,59 }:‘ 2,54 }:‘
Minimum 0 | 0 ——]_
Count 104893 51390

Close Save image

In addition if using ProBat you can do a data validation beforehand:
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Windspeed (m/s) Month Night class
Close Save image

Last step before running the correlation is to select if results are given per species or per
group level. Additionally select if a binary count (based on 10 minutes intervals) or the ac-
tual count of recording sis used for the correlation.

If you have already run a correlation before and have stored the environmental data with
the recordings, a new correlation can be run using the stored values. This allows to create
the graphs without choosing CSV file and columns.

After extracting the data range of the environmental parameter it is distributed evenly over
60 bins (minimum to maximum). When correlating wind speed usually the range is set to 0
m/s to 30 m/s resulting in 0.1 m/s bin widths. The current bin width can be seen in the data
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stored in the clipboard after a successful correlation or from the filter button below the
graph.

The correlation results are shown as line or bar plot, raw data is saved to clipboard in addi-
tion and can be imported into other applications that way. The default line graph shows
cumulated bat activity as percentage above the selected environmental parameter. For
wind speeds 0.5 m/s classes are used, for temperatures 0,5° respectively. By either using
the plots context menu (right-click) or the settings button various display parameters can
be changed. When doing a left-click in the graph the area between the y-axis and the
clicked point is filled with a different colour. That way you can for example click on the 95%
of bat activity point and fill the part left of it indicating wind speeds that will be dangerous
for bats. Finally you can switch between cumulative line display and a bar chart.

@ WEA1.bcAdmindsgl - Environmental correlator
100 388 datasets
000::'9993"9.. vvvvvvvvv T
T o2 wee
s0l2e8e?
90 ..:::_‘A’
T 0e®ta4e®
80 o P iale”
" o A_e0
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—_— 0’/‘0'.
g R
> 60 o5oeT
§ 1 .0v,"i
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8 50 /o.r_/.
3 40 s
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S 1 '/‘/o
&) 30 - f40
r e
T .9:.‘,;'
20 _3’:»:0‘.
1 27 -4= All species -+~ Andere
10 o¥° o
1 o® -e— Nyctaloid -*- Pipistrelloid
O"‘f‘;!:)(())((I)((IIl(IIll(Illlllll()ll())l(l
0 1 2 3 4 5 6 7 8 9 10
Windspeed
Close D I:l Save CSV ... | v | Settings Save image
store values with recordings (windspeed/temperature only) Correlate
Close
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You will need to correlate the recordings first with both these parameters and choose to
save values. That way each recording gets a windspeed and a temperature assigned to.
After activating the use of stored values of the recordings you can show the Wind+temper-

A new feature is to display a scatter plot with temperature and windspeed as axis values.
ature scatter plots.

m |

n
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Save CSV ...

Close

The analysis will test for each recording if it is within our outside the curtailment and give
results for the month of April to October. These are plotted in the display below the set-

tings.

windspeed and/or temperature thresholds or detailled values per month or month and

a curtailement condition. These conditions can be either a rather simple form of either
nighttenth.

Since 2022 a new feature to test curtailment algorithms for wind turbines was added to
bcAdmin. This basically checks for selected sessions, if recordings are within or outside of

9.9. Curtailment analysis



000 | | WEA1.bcAdmin4sql

Sl G RG e el g e Detailed threshold values

windspeed (m/s) Temperature (°C)

Turbine stopped if | <= B | >= B

Filter recordings

| Analyze |
Overall activity outside curtailment 2% 104 Nyctaloid Pipistrelloid
April activity outside curtailment - 0 ---/0 ---/0
May activity outside curtailment - 0 ---/0 ---/0
June activity outside curtailment 2% 10 2 %(2 2 %[6
July activity outside curtailment 0% 0 0 %/0 0 %/0
August activity outside curtailment 0% 2 0 %/0 1%/1
September activity outside curtailment 8% 46 12 %[27 2 %[4
October activity outside curtailment 13% 46 0 %/0 15 %/38
Close Copy results Visualize colorize results

In addition you can plot the distribution of wind speeds for the year and optionally add the
bat events:

000 Curtailment graph

Startup windspeed (m/s) Display when m Simulate
Close Envil | data Scada-Daten WEAO1 (Windsp... B Bats — Save image
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9.10. Georeferencing

The updated feature will soon be explained here.
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10. Data export

10.1. Raw data export to CSV

By using File -> Export to CSV you can export selected recordings and sessions to CSV
in a very flexible way. The export dialog contains all fields that can be exported in the up-
per three groups of items. They are separated by session, location and recording. The
fourth, lowest field acts as container for the actual export. Drag items from the above fields
to the fourth to construct the export. You can save export selection and reload previously
saved export configurations. Stored export configurations can also be set as default for
copy and paste from the session and recordings table. Thus, you can create a CSV string
for the clipboard more quickly.

® 06 B Diss — Bearbeitet
Nl el 1 N
eneN_memc s e | u
[¥] verstecken | Sc [x]
—— Verfigbare Felder mentar.
ALL SESSIONS
Session
PROJECT
LEgrE Anzahl Aufnahmen Bewolkung Critical Freq Datei Er um Er
LOCATIONS Erfassungstart Erstellt am Filecode Gedndert am Kommentar Markierung Mond
Posttrigger Projekt Quality Regen Samplerate Schwelle Sonnenaufgang
Sonnenuntergang Status Verantwortlich Zeitzone max. Temp max. Wind min. Temp
HISTORY -
Standort
FILTER
Anzeigename Geo Region Habitat Klassifizierung Kommentar Land Latitude Longitude
FLAGGED Pfad zu Resourcen Region Stadt Standortname Struktur
Aufnahme
Analysiert am Arten Artzahl Aufnahmezeit Dateiname Dauer Ergebnisse importiert am
Gepriift Klassifikation Kommentar Latitude Longitude Markiert Prozent Nacht
Rufanzahl Temperatur Windgeschwindigkeit
Ausgabe von
Filecode Erstellt am Dateiname Aufnahmezeit Arten
Schli | Voreinstellungen +|| Speichern | | Loschen [ Datei-Export | | Zwischenablage |
@ TS1 04.08.05 160704-bc-04-0024.raw 00:12:31 0,66 0
20:50 - 05:55 160704-bc-04-0025.raw 00:18:21 1,11 2 Bbar 74%
TS1, Ebrach Daten2005 160704-bc-04-0026.raw 00:53:56 3,70 29 Mkm 80%
@ WH5.1 07.09.04 160704-bc-04-0027.raw 01:42:19 0,66 1 Bbar 77%
T o (350 160704-bc-04-0028.raw 01:46:40 0,88 3 Bbar 75%
WHS.1, Ebrach Daten2004 160704-bc-04-0029.raw 02:11:59 0,75 1 Spec. 0%
@ o 09.06.05 160704-bc-04-0030.raw 02:35:22 0,66 1 Bbar 77%
[ - 24 21115 - 0521 160704-bc-04-0031.raw 02:36:27 2,79 20 Mdau 82%

If you have selected species from the list of recording fields, you can chose if you want a
new line for each species (if more than one is stored for a recording) or if all species
should be within one line. The switch for this can be found in the applications preferences.
This is a new feature of bcAdmin 3, in bcAdmin2 always a single line was written for each
recording.

Note: Details regarding the CSV format can be all set in the application preferences via the
Export display. There you can set column or field separator as well as line-ending.
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Locations can be exported to CSV or KML files for further use in GIS applications. Either
use the CSV export described above or the KML export function implemented in the loca-
tions editor.

If recordings are georeferenced, their locations can be exported to KML. Select the record-
ings you want to export and export them via Recordings->Geo-Referencing-YKML Ex-
port.
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11. Preferences

The behaviour of bcAdmin can be fine-tuned using various preferences settings. They in-
fluence the call finder, CSV export or colours used within the application.

11.1. General

Choose the default folder for recordings and if project subgroups should be created auto-
matically.

. N t [ema )
e Preferences - : ] ©
General Display Call finder CoreML Expert Export Keys Backup
Default location for recordings
~ > Documents
Default location (for some suntime calculations)
Latitude / Longitude 53,1099349° 8,4604384°
Default sort order of locations Country, City, Location &
Open with
Raw files Wave files
User selected app [ User selected app [
bcAnalyzed bcAnalyzed
Free time base for activity reports 600 s

automatically generate and update subgroups of projects

Standard labels for new documents

Fertig Schwierig @ Prifen!
Im Winter priifen @ Neu @ Markiert
Halb durch Noch keine Idee @ Bericht erstellt

Update flags in open documents

Furthermore you can select the standard application to open raw and wave files for manu-
al analysis. In addition you can set the labels for session groups and some other details of
how bcAdmin works in general.

11.2. Display

Activate colourisation of recordings within a temporal context if the table is sorted by re-
cording time. Choose if the recordings table formats recordings based on marked/checked
state as well as split recordings. Also activate or deactivate the display of species probabil-
ities shown in the table. Furthermore you can choose sonogram preview parameters here
as well.
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o Preferences - . O/

General Display Call finde CoreML  Expert Export Keys Backup
Recordings table
mark temporal context for intervals < 30s seconds Context color

indicate marked, audited and otherwise tagged recordings
Filename (marked) and species (audited) are printed in bold if the property is set. Unsure species will be
printed in orange. Split/Virtual recordings are shown italic/lighter.

searches are hiding Filter uses logical or (C]

show probabilities with species
Shows probabilities with species names in recording table. The setting is valid for all newly
imported results.

Main window call and sonagram preview

Max. frequency 150 kHz Frequency bands Filled e

Color scheme Blue / Red &

mark files if multiple recordings are selected

sonagram preview call preview frequency bands

ask if too many calls for display Default Don't display (2]

Use larger font for labels in plots

For selections containing more than 300 calls you can opt-in to either hide or show the
calls. If you are showing such amount of calls the display will get slowed down.

The call finder preferences influence how the call finder works. You can set the general
call finder threshold and if this value or the value per session will be used when analysing
calls. Another feature for recordings with a lot of echoes or from long-term monitoring in
the open space is the adaptive call interval. You set a factor and based on the call dura-
tion multiplied with that factor a part of the recording after the call is excluded from the call
finder. That way echoes are not misinterpreted as calls so easily and in general species
results should be improved. Good factors are 3.0 to 7.0.

If you want to gain speed, you may change the parallelisation options. We recommend to
keep the lowest values, if problems occur. That should already be fast enough. If you have
an unstable or very slow call finder, you may want to switch to serial call finding mode that
also blocks all other parts of bcAdmin to avoid interruptions. By checking run parallel call
finder in background the call finder does not block the interface at all but runs invisibly in
the background. This is only recommended for pro users.

Furthermore this dialog lets you choose to use the CoreML classifier instead of batldent.
We do recommend to use the new CoreML-based species identification. If you are using it,
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you can still opt-in to create the csv files that were used by batldent. These nevertheless

are not necessary anymore

@ Preferences

General call finder settings

S~ B N = ©
-

-

General Display Call finder CoreML Expert Export Keys Backup

Clean call data before new analysis

General threshold -36 dB 8

Quality Use CoreML for species ID

Use Sessi ti P vsi You can choose to use the built in CoreML-based

Lt L Ll IL D, LR L, £ species identification instead of batldent. If
5 . g activated, bcAdmin will use CoreML species ID
Adaptive call intervals with factor 5,0 xcall length and stop writing batldent csv files.
Fixed minimum call interval 50 ms §
Generate batldent csv files
You can opt-in to keep generating csv files for
Stereo/Time-delayed settings batldent despite using CoreML. For example will

this allow to also use batldent without

Preferred channel for Stereo files Right 8 remeasuring calls.

Automatically import results when adding recordings

Automatically start identification after call finding

Always use parallel call finder 10 tasks

run parallel call finder in background

11.4. CorelML

In this dialog you can choose specific t

hresholds for accepting a call (left column) as well

as the final result as correct. That means if you choose a threshold of 0.9 (=90%) a call
needs to be at least with a probability of 90% assigned to that species. And if you choose

0.9 (=90%) for the final result in the se
least this overall probability.

cond column, all calls together need to achieve at

[ Preferences - > p1 u (o] \\j
General Display Call finder CoreML Expert Export Keys Backup

Barbastella 0,95 0,8 Nyctaloid 0,8 0,8 Pipistrellus 0,8 0,8
Hypsugo 0,8 0,8 Eptesicus 08 0,85 kuhlii 0,8 0,8
Miniopterus 0,8 0,8 nilssonii 0,8 0,8 nathusii 0,8 0,8
Myotis 08 08 serotinus 08 085 pipistrellus 08 08

alcathoe 0,8 0,8 Nyctalus 0,8 0,8 pygmaeus 0,8 0,8

bart 0,8 0,8 leisleri 0,8 0,8

bechsteinii 0,8 0,8 noctula 0,8 0,8

dasycneme 0,8 0,8 Vespertilio 08 0,85

daubentonii 0,8 0,8 Plecotus 0,6 0,8 1st field: probability threshold per single call

emarginatus 0,8 0,8 Rhinolophus 0,8 0,8 2nd field: probability threshold per recording

myotis 0,8 0,8 Stoerung 09 09

nattereri 0,8 0,8 Tadarida 0,8 0,8
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11.5. Expert

Here you have the possibility to adjust settings that may highly influence the call finder
process, these should be only set by expert users.

- » . D)
(] Preferences - : i ma | N,

General Display Call finder CoreML Expert Export Keys Backup
File deletion Influencing the call finder

move deleted files to trash
The following functions will eliminate calls that were found before using them for
the automatic identification process. Please use these functions only, if you have
Database integrity first tested a dataset without any elimination of data. Or do a check using random
recordings to see if bat calls were filtered out.
automatically check database integrity (weekly)
Criteria for filtering parasite noises
Experimental! filter calls by call length

On the fly sound filter Minimum call length ms Maximum call length ms

may remove calls before display or call search

. N remove calls based on call statistics (per file), only if > 2 calls
activate low pass filter

Quality criterium (call duration) Median 8
Low pass frequency kHz

Criterium bandwidth (call duration) 100%
Q value 15 e 8

activate high pass filter
Hi pass frequency kHz

Q value 15

Cache sonagram images (faster preview on second load)

cache sonagram images of files with durations

>1s 8

The experimental features allow filtering of sound data before display or analysis. Choose
hi and or lowpass filtering to eliminate unwanted noise before analysis and display. This
takes some calculation time but is still quite fast. You can also choose to cache sonagram
images which is useful when accessing files over a network connections. These tend to
have rather a lot of latency.

A new feature is influence of the call finder. The feature to eliminate calls based on a stat-
istical evaluation of call calls of a file shows very promising to get rid of noise like echoes.
This will highly improve the CoreML species identification without sacrificing valuable data.

Manual bcAdmin 4.0 Version 1.4.3 - Page 57



11.6. Export

Parameters for export are used application wide and can be set here. That primarily influ-
ences the creation of CSV files, thus you can set column and decimal separators and
such. If you want activity and species reports not to be transformed when exported to CSV,
you can choose this here as well. Also, if presets for CSV export are stored, you can
choose one here which will be used for copy and paste to other applications.

4

3 2. )
@ Preferences - s = O
General Display Call finder CoreML Expert Export Keys Backup

CSV export options

Field separator ; @ Decimal separator [T
Line separator \n &
quote text " &

Time / date fields - drag below for export format

Day Weekday Week Month Year
Hour Minute Second Timezone

User defined date/time use for session dates e

Jahr ~ - Monat ~ - Tag ~ Stunde ~ :  Minute v :
Sekunde ~ Zeitzone v

24-03-26 15:29:16 CET
Copy and Paste - csv representation presets
Session Copy & Paste No Value s

Recording Copy & Paste Arten_Aufnahmen a

11.7. Key bindings

The file browser as well as the recording table allow the quick adding of species to the se-
lected recording. They key bindings for this feature can be set here application wide. This
allows you to set the species entry of a recording to the one you bound to the according
key. If you use this feature, but want to add a species, just press the alt key when using
the quick key.

11.8. Templates

Choose the default labels for the various flags. These are used then when a new docu-
ment is created. If you created your own colour sets for species you may want to automat-
ically use it for newly created documents. To do this, just choose a PLIUST file created
with the Taxon-Editor.
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12. Miscellaneous

12.1.Licensing

The application runs for ca. 30 days without the need of a license key. If you want to use it
after that period you will need to buy a license. The license will be registered for your
name and email address. Both will be regularly checked by bcAdmin via connecting to our
license server. Thus you need to connect your Mac to the internet at least once a week (a
mechanism exists to prolong this period if you are doing field work for example).

Multiple licenses or multiple computers

We added due to many requests a new feature in bcAdmin 3.0: you now can deactivate
the license for one computer and activate on another, thus you can switch between mul-
tiple Macs. Running bcAdmin is possible only on one simultaneously. If you need to run it
on multiple Macs add your wish, you can also buy additional licenses. The new license
server can be set to allow multiple connections.

Licensee name

Licensee email runkel@ecoobs.de

Updates included 2024
2329214688579869252

Cancel ‘ » Ok
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12.2. Updates

There will be free updates to bcAdmin on a irregular basis. Note that you need a license
including the updates for the current year.
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13. Tips & Tricks

13.1. TimeMachine Backups

Mac OS X comes with a powerful backup tool, directly implemented in the core OS: Time
Machine. It backups you hard disc hourly and allows to travel to various points back in time
if you need to restore a certain version of a document. All you need is an external disk and
allow Mac OS to use it as TimeMachine volume.

13.2. Folder structure for recordings

We can recommend the following structure of folders for recordings to simplify backup and
for moving old projects to archive disks without much hassle for bcAdmin.

Recordings
ProjectA
SESSIONA
ProjectB
SESSIONX
100505
100515
ProjectC
SESSIONA
100601
1007005
SESSIONB
100520
100521
SESSIONC

If you use the SDHC-import feature of bcAdmin, the folders for each night (for example
100505 = May 5th 2010) are created automatically.

This folder structure allows copying of whole projects to an external disk and allow a
simple filelocation change for all sessions belonging to this project.
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Since the introduction of the batcorder-system its usage has changed. While in the begin-
ning single nights were recorded, today the log-term monitoring extensions are used heav-
ily. Thus, large numbers of recordings collected over a long time period have to be
handled. This has implications on the way species identification can be audited. It is hardly
possible to look through each recording and another scheme for auditing has to be used.
The following process can be seen as a prototype for auditing these quantities of data and
can be adapted to your needs. Always keep in mind, that if you work with larger numbers
to not look at absolute sequence counts of species. If you record 10000 N. leisleri and bat-
Ident has an error rate of 10% for misclassification of N. leisleri to V. murinus, you will end
with around 1000 recordings classified as V. murinus. If you recorded 10, it will be 1. Thus,
keep the percentages in your mind!

In a first step, directly after importing batident results we recommend to filter Pipistrelloid
social calls and look at these. Bad quality N. noctula calls tend to get classified as Pip-
istrelloid social calls and this can be quickly evaluated and changed via the batch replace
species command for example. Next look at the species tree and get an overview of identi-
fied species. Then automatically replace species not occurring in your area.

After the first cleanse of identification errors certain species groups, relevant for your pro-
ject should be investigated. We recommend to browse through single nights using the file
brwoser and activate the temporal context colourisation in the recording table. That way
you'll be bale to quickly fix results for groups of recordings belonging to the same bat.
Make heavy use of the quick keys for setting correct species results. Don‘t look at every
single recording than but rely on the fact that a single bat will produce a couple of record-
ings if it is hunting in the vicinity. After some training you should be able to do that task
fairly quickly without many errors. Always allow some checking by randomly selecting.
Even after this second step some misinterpreted results will be left. They may be ignored.
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